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1 INTRODUCTION
Thank you for purchasing the RAYLASE AG weldMARK® software suite. This guide will assist 
you in using the Remote Interface services provided by weldMARK®. The connection is made 
either via an RS-232 interface or via a LAN-based TCP/IP connection.

1.1 About this Manual
The Remote Interface User’s Guide contains detailed information about interfacing to the 
Remote Interface services provided by weldMARK®. It is meant to be a reference tool. It is 
assumed that you have experience in programming of RS-232 ports or TCP/IP connections.

1.2 Laser Safety
Customers assume all responsibility for maintaining a laser-safe working environment. OEM 
customers must assume all responsibility for CDRH (Center for Devices and Radiological 
Health) certification.

CAUTION:

Switch on the PC, before switching on the laser system. In this way you can avoid an uncon-
trolled action of the laser when switching on the PC.

Check your application carefully before using the laser system. Faulty software can lock up the 
complete system without control over the laser or the scan head.

1.3 Manufacturer
RAYLASE AG
Argelsrieder Feld 2-4
82234 Wessling
Germany
Tel.: +49 (0) 81 53 - 88 98 - 0
Fax: +49 (0) 81 53 - 88 98 - 10
http://www.raylase.de
E-mail: info@raylase.de

1.4 Customer Support
The RAYLASE customer service is available for your problems either in respect to the subsys-
tem or to this manual. Before calling the customer service, please make sure you have refered 
to any appropriate sections in the manuals on the supplied CD, that may answer your question.

If you need further assistance call RAYLASE customer service, Monday through Friday 
between 8 a.m. and 5 p.m. (Central European Time).

Germany (Wessling)
+49 (0) 81 53 - 88 98 – 0
E-Mail: support@raylase.de

... ask for the customer service
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2 PRINCIPLE OF OPERATION
This chapter gives an overview of the Remote Interface services provided by weldMARK®, and 
details on configuring weldMARK® properly to communicate with your software.

2.1 Remote Interface Concept
weldMARK® is designed as a full-featured laser marker interface package, with capabilities for 
editing, saving, opening and running “jobs” directly from the weldMARK® Editor interface. 
Although this interface is extremely powerful, it may not be desirable in all circumstances.

For this reason, weldMARK® offers the Remote Interface service. This service provides a 
remote program, written by the customer, the ability to take control of weldMARK®. 

The remote program can load jobs, change the content of marking objects dynamically, run 
jobs and receive status back from weldMARK® after every command. While the remote pro-
gram has control, the weldMARK® User Interface is locked, preventing the operator from mak-
ing any changes to the running process. 

Although jobs that contain motor control objects can be loaded, the Remote Interface does not 
support running jobs with motor control automation.

In operation, the external program takes control of weldMARK®, but does not initiate the actual 
marking cycle. This is done through the START PROCESS input on the Standard I/O card or 
the Start Mark input on the SPC/SPICE series of interface cards. Once the START PROCESS 
pin is toggled, the mark cycle begins, the mark completes, and then weldMARK® returns to wait 
for the START PROCESS pin to toggle again.

Although both TCP/IP and RS-232 interfaces are supported, only one may be active at a time 
for Remote Control.

In addition to the control commands available, there is a number of status query commands 
that can be used to retrieve the current status of weldMARK®. These queries can be made 
even if the remote computer has not taken control of weldMARK®.
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2.2 Configuring the RS-232 Interface
To configure weldMARK® for the RS-232 interface, use the following steps:

￮ Make sure you have a valid RS-232 port set up in Windows. If you are not sure how to do 
this, refer to the Windows documentation.

￮ Connect a standard RS-232 cable between the computer running weldMARK® and your 
remote computer.

￮ In weldMARK® in the main menu, select System >Preferences… 

￮ Select the Show Host mode when application starts box if you want weldMARK® to place 
itself in the Host mode automatically when the application starts first.

￮ To disable the Remote Interface service, click on Host connection to display the Host Inter-
face types available and select disabled.

￮ Select the Host Interface tab.
￮ Click on Host connection to display 

the Host Interface types available.
￮ Select RS-232. 

The beside window is opened.
￮ Edit the default values as desired.
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2.3 Configuring the TCP/IP Interface
To configure weldMARK® for the TCP/IP interface, use the following steps:

￮ Make sure you have a TCP/IP stack installed and set up in Windows. If you are not sure 
how to do this, refer to the Windows documentation.

￮ In weldMARK® in the main menu, select System >Preferences…
The window Preferences is opened. 

￮ Select the Show Host mode when application starts box if you want weldMARK® to place 
itself in the Host ready mode automatically when the application starts first.

￮ To disable the Remote Interface service, click on Host connection to display the Host Inter-
face types available and select disabled.

￮ Select the Host Interface tab.
￮ Click on Host connection to display 

and select TCP/IP.
The TCP/IP default values appear.

￮ Edit the default values as desired.
weldMARK® has been configured to 
listen on Port 350.
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2.4 Configuring the Repeat Process and External Start 
settings 

Note: You must have either a Standard I/O card or a RLC/SP-ICE series scan head card 
installed to use the Remote Interface features in weldMARK®.

To configure weldMARK® for the Remote Interface, the system must be set to repeat the job 
continuously, and to poll the START PROCESS input pin on the Standard I/O card, or the 
START MARK pin on the RLC/SP-ICE card. Note that if you do not select these settings man-
ually, they will be set for you the first time the Host loads a job.

Proceed as follows to configure the settings: 

￮ Enter a message in the Message edit box. It appears in the Host Process box while the sys-
tem is waiting for the START PROCESS input to toggle.

￮ Enter a Timeout value for the maximum waiting time. A value of zero causes an indefinitely 
waiting time.

￮ Select Wait for signal to deassert before triggering to start marking on the trailing edge of 
the START PROCESS signal input. 
Select Trigger immediately while signal is asserted to start marking on the leading edge of 
the START PROCESS signal input. 

￮ Click OK to close the Job Settings window.

￮ In weldMARK®, in the main menu 
click Job >Settings... 

￮ Select the Repeat Process tab.
The adjacent window is opened.

￮ Select the Do not promt between 
cycles, and run indefinitely option.

￮ Select the External Start tab.
The adjacent window is opened.

￮ Select the Wait for external start 
signal option.

￮ Click on drop down menu Use I/O 
port to display the available I/O 
ports.

￮ Select the desired port. Ports are 
only available on the Standard I/O 
card or the SPC/SPICE series scan 
head card.
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2.5 Viewing the Host Interface Monitor
The Host Interface Monitor is a convenient way to view the command sequences between 
weldMARK® and the Host. Note that when the Host has taken control about weldMARK®, the 
Host Interface Monitor position on the display screen cannot be changed. So position it accord-
ingly before taking the control about weldMARK®.

To display the Host Monitor, follow these steps:

￮ In weldMARK®, in the main menu, click View >Host Monitor. The Host Interface Monitor 
window appears.

￮ To close the Host Monitor, in the main menu click View >Host Monitor. The Host Interface 
Monitor window closes.

2.6 Enabling the Host mode
Before another program or computer can take control of weldMARK®, you must put 
weldMARK® into Host mode. Host mode is indicated when the Host Interface window is dis-
played. 
Note: when the Host has taken control about weldMARK®, the Host Interface window position 
on the display screen cannot be changed. So position it accordingly before taking the control 
about weldMARK®.

Proceed as follows to switch weldMARK® in Host mode:

Preparation: 
➜ page 6, Configuring the RS-232 Interface
➜ page 7, Configuring the TCP/IP Interface

￮ Select System >Run from Host from the 
menu.

The Host Interface window appears. 
The system is now ready to accept Remote 
Interface commands 
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2.7 Network connection
By default, weldMARK® makes the Remote Interface service available on Port 350. This can be 
changed in the Host Interface setup box, if Port 350 conflicts with another installed port on your 
computer.

The computer on which weldMARK® is running, can be controlled via an RS-232 direct connec-
tion in the simplest case. Otherwise, control via an TCP/IP network can take place.
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3 COMMANDS AND FUNCTIONS

3.1 Command Syntax
For the sake of clarity, the responses listed below each command have been listed with their 
descriptive error codes. In practice, the responses are returned with numerical error codes. For 
example, STATUS,IN_HOST_MODE is returned as STATUS,512 ( ➜ page 22, Return codes) 
for a complete listing of all return codes.

3.2 Command Set
The following list describes all the Remote Interface commands and their intended use, and is 
presented in alphabetical order. A description of the command parameters follows each com-
mand.

HOME

LOAD,lasercfg,[cardno,]file

Function All the enabled Motor Controller axes are sent in their home position.

Responses ACK Acknowledged

NOT_IN_HOST_MODE weldMARK® must be in Host mode.

NO_MOTOR_CONTROLLER Motor Controller not available.

NO_HARDLOCK
HARDLOCK_NOT_ALLOWED

Either no Hardlock available or the 
feature not allowed with the current 
Hardlock key.

ERROR,MOTOR_HOME An error occurred while performing the 
Home function.

Hints weldMARK® MUST be under host control to accept this command.

Function Loads a laser configuration file to the specified controller card.

Parameter file Full qualified name of the laser 
configuration file, including the path and 
the file name. 
In order to maintain compatibility 
between the two command options, it is
assumed that the file name can not start 
with numbers 0...3.

cardno The specified control board (cardno) 
must be present. If no card number is 
specified, the control board 0 is 
addressed. The value range for cardno is 
0..3.

Responses ACK Acknowledged

UNKNOWN_QUALIFIER Length of the parameter file is less then 
3 characters.

FILE_NOT_FOUND Given path or file name not found.

NO_SUCH_CARD The cardno value is greater than the total 
number of available cards.

Hints weldMARK® MUST be under host control to accept this command.
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LOAD,correctionfile,[cardno,headno,]file

MODIFY,buffer,##,******

Function Loads a correction files for the specified scan head on a controller card.

Parameter file Full qualified name of the correction file, 
including the path and the file name. Both 
.txt and .gcd files with defined name must 
be present at the defined path.
In order to maintain compatibility 
between the two command options, it is 
assumed that the file name can not start 
with numbers 0..3.

cardno,headno Specified cardno and headno should be 
present in the system. If cardno and 
headno are omitted then first card and 
first head are assumed. The value for 
cardno and headno can be in the 
range 0...3.

Responses ACK Acknowledged

UNKNOWN_QUALIFIER Length of the parameter file is less then 
3 characters.

FILE_NOT_FOUND Given path or file name not found.

NO_SUCH_CARD The cardno value is greater than the total 
number of available cards.

NO_SUCH_HEAD The headno value is greater than the 
total number of available heads.

Hints weldMARK® MUST be under host control to accept this command.

Function Stores the string '*****' in the internal string buffer at index ##.

Parameter ## Number of the string buffer (value 
between 1 and 10)

'*****' string

Responses ACK Acknowledged

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized.

ERROR,NO_SUCH_BUFFER Buffer ## out of range.

ERROR,INVALID_TEXT The length of the ***** string is zero, or 
does not contain markable characters.

Hints Text objects within the job must have their "Source" set to Get String from Memory 
buffer to use the buffer contents.

weldMARK® does not need to be under host control to accept this command.

Calling this, will clear the previous value stored in buffer.
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MODIFY,field,##,******  

MODIFY,headoffset,cardno,headno,xoffset,yoffset  

Function Modifies a field of text or barcode.

Parameter ##  Number of field to be modified

 "*****" New text string

Responses ACK Acknowledged

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized.

ERROR,UNKNOWN_QUALIFIER The ## field was not an integer value.

ERROR,NO_SUCH_FIELD The ## field index is larger than the total 
number of objects loaded.

ERROR,UNKNOWN_QUALIFIER The length of the ***** string is zero, or 
does not contain markable characters.

Hints weldMARK® MUST be under host control to accept this command.

The field ## corresponds to the position the object has in the Object List within the 
job i.e. the first object in the Object List would have an index value of 1. If the index 
values are not known at run time, use MODIFY buffer instead. If the field does not 
exist, an error is returned.

The marker must be OFFLINE. 

Function Modifies the head parameter xoffset and yoffset.

IMPORTANT
Offset values set with this command are saved in the job as HeadOffset values.
Be sure to reset the values to „0“ if they should not be used in the job any further.

Parameter cardno,headno Card and the head numbers in the range 
0..3.

xoffset,yoffset Offset values are absolute and should be 
specified in bits.

Responses ACK Acknowledged

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized.

ERROR,UNKNOWN_QUALIFIER The defined cardno or headno values are 
not an integer value.

ERROR,NO_SUCH_CARD The defined cardno value is greater than 
the total number of available cards.

ERROR,NO_SUCH_HEAD The defined headno value is greater than 
the total number of available heads.

Hints weldMARK® MUST be under host control to accept this command.

No checking is done if the values are exceeded.

No checking is done if the job is loaded or running. It is up to the calling application 
to check that changing offset values will not disturb current marking, since the 
changes are effective immediately.
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MODIFY,position,##,dX,dY

MODIFY,rotation,##,dangle

MODIFY,wsrotation,angle

Function Modifies the position of an object by a certain x and y offset.

Parameter ##  Number of the object to be modified

dX, dY Offsets in bits

Responses ACK Acknowledged

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized.

ERROR,UNKNOWN_QUALIFIER The ## field was not an integer value.

ERROR,NO_SUCH_OBJECT The ## field index is larger than the total 
number of objects loaded.

Hints weldMARK® MUST be under host control to accept this command.

Job must be loaded and the marker must be OFFLINE. If the object does not exist, 
an error is returned.

Function Rotates an object by a certain angle.

Parameter ##  Number of the object to be rotated.

dangle Degree value to rotate the object. Range: 
-360 to 360

Responses ACK Acknowledged

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized.

ERROR,UNKNOWN_QUALIFIER The ## field is not an integer value.

ERROR,NO_SUCH_OBJECT The ## field index is greater than the total 
number of objects loaded.

Hints weldMARK® MUST be under host control to accept this command.

Job must be loaded and the marker must be OFFLINE. If the object does not exist, 
an error is returned.

Function Rotates working space by a certain angle.

Parameter angle Degree value to rotated the working 
space. Range: -360 to 360

Responses ACK Acknowledged

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized.

ERROR, ANGLE_OUT_OF_RANGE Value angle is out of range -360 to 360.

Hints weldMARK® MUST be under host control to accept this command.

Job must be loaded and the marker must be OFFLINE. If the object does not exist, 
an error is returned.
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OFFLINE

ONLINE

OPEN,file,######

Function Commands the laser to stop marking immediately, and returns the laser to the 
MARKER_OFFLINE state.

Responses ACK Acknowledged

ERROR,ALREADY_OFFLINE Marker is already offline.

Hints weldMARK® MUST be under host control to accept this command.

Function Commands the marker to start the marking process.

Responses ACK Acknowledged

ERROR,ALREADY_ONLINE Marker is marking or waiting for external 
start signal.

ERROR,NO_JOB_LOADED No job loaded.

ERROR,INTERLOCKS_OPEN An interlock port on the interlock I/O card 
is signaled.

ERROR,NO_SCANCARD There is no scan head card installed in 
computer.

ERROR,NO_HARDLOCK No Hardlock detected.

ERROR,NO_IOCARD No I/O card installed in computer.

ERROR,STEP_REPEAT_INVALID The values saved in the job for „step and 
repeat“ will result in an invalid object 
position.

ERROR,TEXT_SOURCE_INVALID A text object was saved with a Source 
value incompatible with the host 
interface.

ERROR,TEXTMERGE_INVALID There was an error while processing a 
TextMerge file.

ERROR,OBJECT_OUT_OF_BOUNDS There is an object in the job that is 
outside the legal marking field.

Hints weldMARK® MUST be under host control to accept this command.

System will start polling external start port immediately and enter 
MARKER_ONLINE state. This call automatically sets the external start flag to true, 
and sets the repeat mode to repeat indefinitely.

Function Opens a file.

Parameter "####" Text string describing the file to be 
opened.

Responses ACK Acknowledged

ERROR,FILE_NOT_FOUND The file was not found at the indicated 
path location, or there was an error while 
opening the file.

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized.

ERROR,UNKNOWN_QUALIFIER The file path was less than 3 characters 
in length.

Hints weldMARK® MUST be under host control to accept this command.

The text string must be a fully qualified UNF file path. If the file cannot be found or is 
corrupt, an error code is returned.
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REQUEST,data,cyclecount

REQUEST,data,cycletime

REQUEST,data,jobname 

REQUEST,data,objectnumber

Function Requests weldMARK® to return the number of current job repetitions.

Parameter cyclecount Indicates the number of full cycles, 
including „step and repeat“.

Responses DATA,x „x“ is the current cycle count.

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized.

Hints weldMARK® does not need to be under host control to accept this command.

Function Requests weldMARK® to return the current cycle time.

Parameter cycletime Elapsed time to do all marks within a 
single cycle.

Responses DATA,x „x“ is the current cycle time.

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized.

Hints weldMARK® does not need to be under host control to accept this command.

Function Requests weldMARK® to return the name of the currently loaded job.

Responses DATA,filepath filepath is the fully qualified path to the 
currently loaded job file.

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized.

Hints weldMARK® does not need to be under host control to accept this command.

Function Requests weldMARK® to return the object number of the currently marked object.

Responses DATA,x x is the currently marked object index in 
the range: 0 ... last object index.

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized.

Hints weldMARK® does not need to be under host control to accept this command.

If a job is not running the returned value for current object index is 0.
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REQUEST,data,partcount 

REQUEST,data,parttime

REQUEST,data,version

REQUEST,data,user 

Function Requests weldMARK® to return the number of marked objects.

Parameter partcount Part count of individual mark within a 
cycle.

Responses DATA,x „x“ is the current part count.

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized.

Hints weldMARK® does not need to be under host control to accept this command.

Function Requests weldMARK® to return the current part mark time.

Parameter parttime Elapsed time to do a single mark within 
an overall cycle.

Responses DATA,x „x“ is the current part time.

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized.

Hints weldMARK® does not need to be under host control to accept this command.

Function Requests weldMARK® to return its version number.

Responses DATA,x „x“ is the version number.

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized.

Hints weldMARK® does not need to be under host control to accept this command.

Function Requests weldMARK® to return the User currently logged on to the current 
Windows session.

Responses DATA,username username is the currently logged in user.

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized.

Hints weldMARK® does not need to be under host control to accept this command.
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REQUEST,field,## 

REQUEST,status,interface

REQUEST,status,marker

Function Requests data from a field of text, barcode or graphic.

Parameter ## Number of the field to be queried.

Responses DATA,field#,objecttype,data field# is the field# of the object

objecttype ➜ page 23, Object Types.

data is the string value for text and 
barcodes and the graphic file path for a 
graphic object.

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized

ERROR,UNKNOWN_QUALIFIER The ## field was not an integer value.

ERROR,NO_SUCH_FIELD The ## field index is larger than the total 
number of objects loaded.

Hints weldMARK® must be under host control to accept this command.

The marker must be OFFLINE. If the field does not exist, an error is returned.

Function Returns the current status of the host interface.

Responses STATUS,IN_HOST_MODE Host is in control of weldMARK®.

STATUS,HOST_NOT_READY Not available for host command.

STATUS,HOST_READY Available for host command.

Hints weldMARK® does not need to be under host control to accept this command.

Function Returns the current system and weldMARK® software status.

Responses STATUS,HOST_NOT_READY Cannot get status of marker because
host is not available for host command.

STATUS,INTERLOCKS_OPEN An interlock port on the interlock I/O card
is signaled.

STATUS,MARKER_ONLINE Marker is marking or waiting for external
start signal.

STATUS,MARKER_OFFLINE Job is loaded and marker is ready to
accept ONLINE command or MODIFY
command.

STATUS,NO_JOB_LOADED No job loaded.

STATUS,ERROR_PROCESS There was an error in the ONLINE mode.
This error will be cleared after it is read
once, and if all OK, the next response will
be STATUS,MARKER_OFFLINE.

Hints weldMARK® does not need to be under host control to accept this command.
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REQUEST,status,job

Function Requests weldMARK® to return the current job status to enable detection if a job is 
being paused. This can happen while the job is waiting for something, like an 
External Start Signal, or when executing an Automation object.

Responses JOBSTATUS,Job status message Full list of job status messages.

ERROR,UNKNOWN_VERB First word in command line not 
recognized.

ERROR,UNKNOWN_NOUN Second word in command line not 
recognized.

Job status 
messages

<empty string>
An empty string is returned as the job status message in host and local mode, if a job is not 
running. It is irrespective of whether the job is loaded or not. Even after a job has finished run-
ning an empty string is returned.

LASER ON - processing:<ObjectName>
When a job is marking an object, it is indicated by “LASER ON – processing:” string with the 
object name appended.

Waiting ...
Default values for the string are:
- “Waiting for external start signal...” for a job and
- “Waiting on port” for an Automation object within a job.
NOTE: These messages can be changed either for each object or on a system basis. In which 
case it will be taken as default value and will affect all objects and jobs. It can be changed at 
various points:
- Job >Settings >External Start
- Object >Defaults >Wait for External Start
- Object >Properties >Settings
- In Registry: 
      for a Wait for external start before a job is executed change
         HKCU\Software\RAYLASE\weldMARK\ProcDefaults\ExternalStartMsg 
      and for 'Wait on port' object in
         HKCU\Software\RAYLASE\weldMARK\ObjDefaults\WaitOnPort\message

AUTOMATION - processing: ObjectName
When a job is waiting for an automation object to be executed, it is indicated by “AUTOMA-
TION – processing:” string with the object name appended.

LASER ON &&AUTOMATION - processing: ObjectName
When a job is waiting for a combined marking object with automation to be executed (like 
marking text with Rotary indexer).
Calibrating scan head. Please wait...
When a job is waiting for the Autocalibration to be executed.

Hints weldMARK® does not need to be under host control to accept this command.
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REQUEST,status,marker

RUN

Function Returns the current status of the laser marker and the weldMARK® software

Responses STATUS,HOST_NOT_READY Cannot get status of marker because 
host is not available for host command.

STATUS,INTERLOCKS_OPEN An interlock port on the interlock I/O card 
is signaled.

STATUS,MARKER_ONLINE Marker is marking or waiting for external 
start signal.

STATUS,MARKER_OFFLINE Job is loaded and marker is ready to 
accept ONLINE command or MODIFY 
command.

STATUS,NO_JOB_LOADED No job loaded.

STATUS,ERROR_PROCESS There was an error in the ONLINE mode. 
This error will be cleared after it is read 
once, and if all OK, the next response will 
be STATUS,MARKER_OFFLINE.

Hints weldMARK® does not need to be under host control to accept this command.

Function Commands the laser system to start the marking process.

Responses ACK Acknowledged

ERROR,ALREADY_ONLINE Laser is marking or waiting for external 
start signal.

ERROR,NO_JOB_LOADED No job is loaded.

ERROR,INTERLOCKS_OPEN An interlock port on the interlock I/O card 
is signaled.

ERROR,NO_SCANCARD There is no scan head card installed in 
computer.

ERROR,NO_HARDLOCK No hardlock detected.

ERROR,NO_IOCARD No I/O card installed in computer.

ERROR,STEP_REPEAT_INVALID The values saved in the job for „step and 
repeat“ will result in an invalid object 
position.

ERROR,TEXT_SOURCE_INVALID A text object was saved with a source 
value incompatible with the host 
interface.

ERROR,TEXTMERGE_INVALID There was an error while processing a 
TextMerge file.

ERROR,OBJECT_OUT_OF_BOUNDS An object of the job is out of the marking 
field.

Hints weldMARK® must be under host control to accept this command.

The system will execute the currently loaded job immediately and enter the 
MARKER_ONLINE state. This call does not set the external start flag to „true“ 
automatically, and does not set the repeat mode to „repeat indefinitely“. The current 
job settings will be used for these two parameters.
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SET,control,host

SET,control,local

Function Puts weldMARK® into Host mode.

Responses ACK Acknowledged

ERROR,ALREADY_IN_HOST_MODE weldMARK® is already in Host mode.

ERROR,HOST_NOT_READY weldMARK® cannot switch to Host mode 
because the Allow Host Control check 
box in weldMARK® is cleared.

Hints weldMARK® cannot be under host control to accept this command.

All user input via the console is disabled.

Function Stops the external control of weldMARK®.

Responses ACK Acknowledged

ERROR,ALREADY_IN_LOCAL_MODE Host is already in local mode.

ERROR,MARKER_ONLINE Laser is marking or waiting for external 
start signal.

Hints weldMARK® must be under host control to accept this command.
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3.3 Return codes
The following numerical response codes are returned by weldMARK®:

When the remote system tries to connect to weldMARK®, instead of numeric values, following 
response strings are returned:  "Host Interface: Ready" or "Host Interface: Access Denied".

Numerical Code Descriptive Code

204 UNKNOWN_VERB 

205 UNKNOWN_NOUN

206 UNKNOWN_QUALIFIER

209 INVALID_STRING

221 NO_JOB 

231 NO_SUCH_OBJECT

232 NO_SUCH_CARD

233 NO_SUCH_FIELD

234 NO_SUCH_HEAD

235 NO_SUCH_BUFFER

236 NOT_IN_HOST_MODE

240 ALREADY_OFFLINE 240

241 ALREADY_ONLINE

242 NOT_OFFLINE

243 NOT_ONLINE

244 ALREADY_IN_HOST_MODE

245 ALREADY_IN_LOCAL_MODE

246 ANGLE_OUT_OF_RANGE

250 SERVER_NOT_READY

400 INTERNAL_ERROR

510 HOST_READY

511 HOST_NOT_READY

512 IN_HOST_MODE

2000 FILE_NOT_FOUND

2010 FILE_TYPE_NOT_SUPPORTED

2300 MARKER_OFFLINE

2301 MARKER_ONLINE

2350 NO_MARKER_LIBRARY

3000 INTERLOCKS_OPEN

3010 NO_SCANCARD

3011 NO_HARDLOCK

3012 NO_IOCARD

3013 NO_LASER_INIT

3014 HARDLOCK_NOT_ALLOWED

3020 INVALID_STEP_REPEAT

3021 INVALID_TEXT_SOURCE

3022 TEXTMERGE_ERROR

3040 OBJECT_OUT_OF_BOUNDS

3041 NOT_ALLOWED_WITH_CURRENT_HARDWARE_KEY



Commands and Functions Chapter 3

MN061 / v3.2.0 RAYLASE weldMARK 3 - Remote Interface 23

3.4 Object Types
Note: Not all of these object types are available through the host Interface. They are included 
here for completeness.

The following object types are returned by the weldMARK® Editor:

Numerical Code Object Description

7 MCL Graphic

8 EPS Graphic

9 DXF Graphic

10 System Line

11 System Rectangle

12 System Polygon

13 PLT Graphic

14 EMF Graphic

15 WLO Graphic

16 Text

17 System Drill

18 Barcode 39

19 Barcode CodaBar

20 Barcode 93

21 Barcode 128

22 Barcode 2 of 5

23 Barcode PostNET

24 Barcode UPC

25 Barcode EAN

26 DataMatrix

27 QRCode

28 Bitmap Graphic

29 Wait On Port I/O

30 Set Port I/O

31 Time Delay

32 Message Box

33 Generic Motor Controller

34 XY Table Controller

35 Rotary Indexer Controller

36 Laser Lift Controller
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4 EXAMPLE PROGRAM
An example program is provided to illustrate how to initiate a session with weldMARK®. It 
shows how to adjust an object in the loaded job, how to run a job and how to close the session.

4.1 C++ Example
The following pseudo-code uses an application defined function called SendToSocket(), which 
represents a method of outputting text either from the RS-232 interface or TCP/IP ports and 
receiving a response as it's return value. 

//Aquire weldMARK®
SendToSocket ("SET,control,host");
//Make sure we have control
if (SendToSocket ("REQUEST,status,interface")!=" STATUS,512")return ERROR;
//Load a job
SendToSocket ("OPEN,file,c:\\programme\\raylase\\weldmark\\job\\test.wmj");
//Make sure job has loaded properly
if (SendToSocket ("REQUEST,status,marker")!=" STATUS,2300")return ERROR;
//Change the text in the object at index position 2
SendToSocket ("MODIFY,field,2,"Hello World");
//Put weldMARK into the ONLINE mode, waiting for START PROCESS to toggle
SendToSocket ("ONLINE");
//Verify we are in ONLINE MODE
if (SendToSocket ("REQUEST,status,marker")!=" STATUS,2301")return ERROR;
//Mark some parts
.
.
//Stop polling the START PROCESS input
SendToSocket ("OFFLINE");
//Release weldMARK
SendToSocket ("SET,control,local";
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